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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted 
in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON scanner. EPSON is not responsible for any use of this information as applied to other 
scanners.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: 
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, 
or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and 
maintenance instructions.

SEIKO EPSON CORPORATION and its affiliates shall not be liable for any damages or problems arising from 
the use of any options or any consumable products other than those designated as Original EPSON Products 
or EPSON Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials
Digital cameras and scanners, like photocopiers and conventional cameras, can be misused by improper 
copying of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in 
certain circumstances, those circumstances may not be as broad as some people assume. EPSON 
encourages each user to be responsible and respectful of copyright laws when using digital cameras and 
scanners.
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Trademarks
EPSON is a registered trademark of SEIKO EPSON CORPORATION. Perfection and EPSON FaxAdvice are 
trademarks and EPSON SoundAdvice is a service mark of Epson America, Inc.

General Notice:  Other product names used herein are for identification purposes only and may be 
trademarks of their respective companies.
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Introduction

EPSON® TWAIN is the interface program between your application 
software and scanner that lets you scan images into your software. It is 
the ideal interface for producing professional quality images, scanning 
text into optical character recognition (OCR) programs, and managing 
text pages in NewSoft™ Presto!™ PageManager™. 

EPSON TWAIN includes many features for previewing and modifying 
your images for the perfect scan:

◗ Captures all kinds of image types, from black and white text to 36-bit 
color images

◗ Automatically locates and exposes the image

◗ Opens a preview image allowing you to change settings and view their 
effects before you scan

◗ Provides a helpful marquee feature so you can frame the exact image 
borders or only portions of it for scanning

◗ Uses EPSON’s Auto Area Segmentation and Text Enhancement 
Technology features to improve text recognition and provide clear 
separation from graphic areas when you scan images with text

◗ Gives you predefined settings for a variety of image types and output 
destinations and lets you customize your own settings
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Here is a brief overview of scanning steps using the EPSON TWAIN 
Advanced window (the Windows® interface is shown; the Macintosh® 
steps are the same):

2 Preview your image

3 Auto Locate the 
image to crop it

1 Select the basic settings:
Document Source
Image Type
Destination
Resolution

4 Size or scale the image 
(don’t forget to increase 
the Resolution if you 
increase the size or 
scale

5 Save your Settings, select 
your preview Configuration, 
and use color management

6 Scan the image into
your application
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EPSON TWAIN also comes with these utilities:

◗ EPSON Scanner Monitor (Macintosh) or Scan Events (Windows) 
utilities that let you scan with Presto! PageManager using the Start 
button

◗ EPSON Screen Calibration utility to calibrate your screen to your 
scanner for accurate previews

◗ EPSON Scan! II (Macintosh only), a TWAIN-compliant application you 
can use for basic scanning and exporting of images (if you don’t have 
a TWAIN-compliant image editing application)

System Requirements 
Before installing the scanner software, make sure your system meets the 
following requirements.

Windows System Requirements
◗ Microsoft Windows NT® 4.0, Windows 95, or Windows 98 preinstalled 

(USB support requires Windows 98)

◗ PC with an available built-in USB port or hub connection or a PCI slot 
for the SCSI card (included with the Perfection™ 1200S)

◗ VGA or higher standard monitor with 640 × 480 resolution (800 × 600 
or higher recommended) and 256 colors (65,000 colors or more 
recommended)

Color and tone 
reproduction depend 
on the display 
capabilities of your 
computer system, 
including the video 
controller, monitor, 
and software. 
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Macintosh System Requirements 
EPSON TWAIN supports the Apple® ColorSync™ 2 color management 
system and QuickTime.™ 

◗ Apple Macintosh computer running system 8.1 or later

◗ Available iMac or G3 standard USB interface or hub connection, 
(Perfection 1200U), or Macintosh standard SCSI Port (Perfection 
1200S)

◗ Color monitor with 640 × 480 resolution (800 × 600 or higher 
recommended) and 256 colors (32,000 colors or more recommended)

How to Use This Manual
For instructions on installing EPSON TWAIN, see the Scanner Basics 
book. This User’s Guide tells you what you need to know to scan with 
EPSON TWAIN and use the TWAIN utilities. 

Basic Scanning gives step-by-step instructions for basic scanning and 
previewing of your images.

Advanced Scanning describes advanced EPSON TWAIN procedures, 
such as scanning with the optional transparency unit and auto document 
feeder, customizing image type and destination settings, adjusting image 
size and scale, using image controls, tone correction, and color 
adjustments, saving custom setting groups, and configuring TWAIN.

Using the EPSON TWAIN Utilities tells you how to use EPSON Scan! II, 
the scanner monitor utilities, and EPSON Screen Calibration (Macintosh 
only).

If you’re using Mac 
OS 8.1 on your iMac, 
you must install the 
iMac Update 1.0, 
available from the 
Apple web site, 
before installing your 
scanner software. If 
you’re using Mac OS 
8.5 or later, check the 
Apple web site for 
any updates.
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Using the Start Button gives step-by-step instructions on setting up and 
using your scanner’s Start button for one-touch scanning.

Troubleshooting provides solutions to problems you may encounter.

At the end, you’ll find a Glossary and an Index.

Cautions, Notes, and Tips
You’ll find this information throughout your manual:

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your scanner.

Tips contain additional hints for better scanning.

Using Electronic Links
Blue underlined text indicates a link (cross-reference) to other parts of this 
guide. Click on the link text with the mouse pointer to view the referenced 
information. 
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Basic Scanning

Before scanning, make sure you’ve installed the EPSON TWAIN software 
(as described in the Scanner Basics book) and the application software 
that supports EPSON TWAIN, such as Adobe® PhotoDeluxe® or Presto! 
PageManager.

This chapter gives you instructions on:

◗ Starting EPSON TWAIN

◗ Selecting Basic Settings

◗ Previewing Your Scan

If you’re scanning with the optional transparency unit or auto document 
feeder, see these sections for basic scanning instructions:

◗ Scanning Transparencies

◗ Scanning with the Auto Document Feeder

EPSON Scan! II 
(Macintosh only) is a 
TWAIN-compliant 
application supplied 
with EPSON TWAIN 
in case you don’t have 
a TWAIN-compliant 
program for scanning. 
For best results, 
use one of the 
TWAIN-compliant 
applications that came 
with the scanner 
instead. See Using 
EPSON Scan! II for 
instructions on 
scanning with 
EPSON Scan! II.
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Starting EPSON TWAIN
Follow the steps in this section to start EPSON TWAIN from your 
application software. The steps may vary, depending on your application. 

1 Make sure you set up and turned on the scanner. Then place the 
document you want to scan on the document table. See the Scanner 
Basics book for instructions.

2 Start your application software by selecting the program icon in its 
program folder.

3 Select the scanner source. Open the File menu and choose Import , 
Acquire , or Select Source , and then select either Select TWAIN_32 
Source  (Windows) or TWAIN Select  (Macintosh). 

4 Select either EPSON TWAIN 4 (32-bit)  (Windows) or EPSON 
TWAIN 4 (Macintosh) and click Select . 

5 Start EPSON TWAIN for scanning. Open the File menu and choose 
Import  or Acquire  and then select either TWAIN_32 (Windows) or 
TWAIN Acquire (Macintosh).

If you start your 
application software 
before turning on your 
scanner, the software 
may not work 
properly.

The steps in this 
section cover 
scanning with 
common 
TWAIN-compliant 
applications. Other 
applications, such as 
PhotoDeluxe, use 
different scanning 
steps. See your 
Scanner Basics book 
for instructions on 
scanning with 
PhotoDeluxe; see 
your application’s 
documentation for 
additional details on 
scanning.

Click to select 
the scanner 
source

Click to open 
EPSON TWAIN
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One of the EPSON TWAIN windows appears.

The first time you start EPSON TWAIN, you see the Easy window. After 
that, you’ll see the window that was open the last time you closed EPSON 
TWAIN. To switch between the windows, click the Easy  or Advanced  
button.

Both the Easy and Advanced windows contain the basic settings you 
need to scan an image. See Selecting Basic Settings for details.

The Advanced window lets you preview your image and select many 
advanced settings. See Previewing Your Scan and Advanced Scanning 
for details.

Advanced window

Easy window 

The screen examples 
in this book are from 
EPSON TWAIN for 
Windows. The 
screens for 
Macintosh look a bit 
different, but they 
contain the same 
options. Any 
exceptions are noted 
in the text.



Basic Scanning Page 16

Selecting Basic Settings
For most scans, you need to check four basic settings: Document 
Source , Image Type , Destination , and Resolution  (Advanced window 
only). 

1 You only need to change the Document Source setting if you’ve 
installed an optional transparency unit (TPU) or auto document feeder 
(ADF) on your scanner.

If you’re scanning a document from the scanner’s document table, 
select Flatbed  (default) as the Document Source  setting. If you’ve 
installed the optional auto document feeder or transparency unit on 
your scanner, select one of the following options in the Document 
Source list:

For detailed steps in scanning with the optional transparency unit or 
auto document feeder, see Scanning Transparencies or Scanning with 
the Auto Document Feeder.

Setting Type of document source

ADF (Windows)
Auto Document Feeder 
(Macintosh)

For scanning single-sided documents up to 
legal size (8.5 × 14 inches) using the auto 
document feeder

TPU for neg. Film For scanning negative film with the 
transparency unit, such as negative film strips

TPU for pos. Film For scanning positive film with the 
transparency unit, such as slides

Document Source 
settings for optional 
equipment appear in 
the list only when that 
option is installed.

If you’re scanning 
positive, reflective 
originals (such as a 
photograph) with the 
optional transparency 
unit installed, be sure 
to turn off the 
transparency unit. 
Then select Flatbed  
as the Document 
Source option.
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2 You must select the correct Image Type setting each time you scan. 
These image types automatically select other TWAIN settings that are 
the best for your type of image and set the ranges for your Image 
Controls. Select one of the following options:

Setting Type of image (positive or negative)

Color Photo For color photographs

Color Photo 
De-screening

For color images scanned from pre-printed 
material

Black & White Photo For black and white photographs

Line Art For black line drawings

OCR For black text that will be input into an OCR 
(Optical Character Recognition) application; 
optionally uses the Text Enhancement 
Technology feature

Copy & Fax For text and graphic images in a document that 
you intend to copy or fax; uses the Auto Area 
Segmentation feature

To view the default 
settings for the Image 
Type you selected, 
click the Image Type  
button.

You can also change 
the settings for these 
options or save your 
own custom Image 
Types. See 
Customizing Image 
Types for more 
information.
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3 Now select the output device where you want to display or print your 
scanned image from the Destination list. These destinations 
automatically select resolution and sharpness settings appropriate for 
the output device. Select one of the following options:

Setting Type of output device

Screen/Web For viewing on a monitor screen or within a 
web page

EPSON printer For printing on your EPSON ink jet printer

Laser Printer For printing on a laser printer

Fax For sending to a fax machine or fax/modem

OCR For sending to an OCR (Optical Character 
Recognition) application

To view the default 
settings for the 
Destination you 
selected, click the 
Destination button.

You can also change 
the settings for these 
options or save 
your own custom 
destinations. See 
Customizing 
Destination Settings 
for more information.
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4 The Image Type and Destination settings you choose automatically 
select the correct Resolution setting for your image. 

If you need to change the resolution, click Advanced  to open the 
Advanced window, if necessary. Then select a new setting from the 
Resolution list. The available resolutions range from 50 to 9600 dpi 
(dots per inch). You can also type in a specific Resolution  setting, 
such as 1600 or 2400 dpi for enlargements, if it’s not in the list. 

If you enlarge your target image size by scaling or by selecting a larger 
Target size, be sure to increase the Resolution setting by the same 
proportion to retain your image quality. See Adjusting Source and 
Target Image Sizes for more information.

For additional information on selecting scanning resolution, see your 
Scanner Basics book.

5 It’s a good idea to preview your image before you actually scan so you 
can make any necessary changes. To preview your image, click 
Advanced  to open the Advanced window, if necessary. Then see 
Previewing Your Scan for preview instructions. 

See Advanced Scanning for information on the rest of the TWAIN 
settings in the window.

6 When you’re ready to scan, click the Scan  button. The scanned image 
appears in your application window.

7 Click the Close  button to close the EPSON TWAIN window and return 
to your application.

To modify or save your scanned image using your application 
software, see your software documentation. 

With applications that 
let you select ICM, 
sRGB, or ColorSync 
profiles for your 
printer, you’ll get 
great printed output 
when you scan 
using ICM/sRGB 
(Windows 98) or 
ColorSync 
(Macintosh). See 
Configuring Preview 
and Color Options for 
details.
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Previewing Your Scan
You can preview your image in the Advanced window to see the effects of 
your settings before scanning. Previewing also allows you to determine 
the width and height of the scanned image and the final file size. 

In the Advanced window, click the Preview button to preview the entire 
image area.

If you want to crop the image, you can preview and use a marquee. Then 
you can zoom into the cropped area using the Zoom Preview button. 
See Using Marquees for instructions.

If you want to save your preview image and settings after closing EPSON 
TWAIN, or select other previewing options, see Configuring Preview and 
Color Options for instructions.

You cannot preview 
an image that 
exceeds your 
system’s available 
memory or disk 
space. 

Although the preview 
image changes when 
you modify settings, 
the settings don’t 
affect the image until 
you scan it.

preview 
image area
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Using Marquees
A marquee is a frame around an entire image, or a portion of an image so 
you can scan only the most important part. To create a marquee, follow 
these steps:

1 Move the mouse pointer over the preview image; the pointer becomes 
a cross hair. 

2 Position the pointer in the corner of the area you want to select and 
press the mouse button.

3 Hold down the mouse button as you drag the mouse across the image, 
creating a marquee. 

4 Release the button when the marquee contains the image area you 
want.

5 To enlarge the preview of the new image area, click the Zoom 
Preview button.

If you need to adjust the marquee size or position, or delete the marquee, 
see Adjusting a Marquee. 

If the mouse pointer 
doesn’t change to a 
cross hair, click the 

Preview button 
again.

marqueeYou can save 
different sets of 
settings for your 
marquee and then 
batch scan all the 
variations. See Batch 
Scanning for details.
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Adjusting a Marquee
To resize a marquee, place the mouse pointer over 
its edge; the pointer changes to a double-headed 
arrow. Click the mouse button and drag the box up, 
down, sideways, or diagonally to the size you want. 

To resize a marquee and retain its width-to-height 
proportions, hold down the Shift  key as you drag the 
edge of the marquee.

To move a marquee, place the mouse pointer 
anywhere in the marquee image area; the pointer 
changes to a hand. Click the mouse button and drag 
the entire marquee to move it where you want it.

To delete a marquee, double-click anywhere in the 
preview image area.
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Advanced Scanning

The instructions in this chapter tell you how to perform these advanced 
scanning operations:

◗ Scanning Transparencies

◗ Scanning with the Auto Document Feeder

◗ Customizing Image Types

◗ Customizing Destination Settings

◗ Adjusting Source and Target Image Sizes and scaling

◗ Using Automatic Adjustment Features, such as Auto Locate and Auto 
Exposure

◗ Adjusting Image Controls, such as the exposure, highlights, and 
shadows

◗ Using Tone Correction

◗ Using Color Adjustments, such as saturation

◗ Saving Custom Settings and Batch Scanning

◗ Configuring Preview and Color Options 

The screen examples 
in this book are from 
EPSON TWAIN for 
Windows. The 
screens for Macintosh 
look a bit different, 
but they contain the 
same options. Any 
exceptions are 
noted in the text.
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Scanning Transparencies
When you scan with the optional transparency unit (TPU) installed, you 
need to select the correct basic settings in EPSON TWAIN. Before you 
begin, make sure you’ve installed and turned on the transparency unit, 
then place your transparent original in the unit. See your Scanner Basics 
book for instructions.

For most scans, you need to check four basic settings: Document 
Source , Image Type , Destination , and Resolution  (Advanced window 
only). Follow these steps:

1 Select one of the following options in the Document Source list, 
depending on the type of transparency you’re scanning:

Setting Type of document source

TPU for neg. Film For scanning negative film with the 
transparency unit, such as negative film strips

TPU for pos. Film For scanning positive film with the 
transparency unit, such as slides

If you’re scanning 
positive, reflective 
originals (such as a 
photograph) with the 
optional transparency 
unit installed, be 
sure to turn off the 
transparency unit. 
Then select Flatbed  
as the Document 
Source option; see 
Selecting Basic 
Settings for 
instructions.

Maximum 
transparency area is 
4 × 5 inches.
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2 You must select the correct Image Type setting each time you scan. 
These image types automatically select other TWAIN settings that are 
the best for your type of image and set the ranges for your Image 
Controls. Select one of the following options:

Setting Type of image (positive or negative)

Color Photo For color photographs

Color Photo 
De-screening

For color images scanned from pre-printed 
material

Black & White Photo For black and white photographs

Line Art For black line drawings

OCR For black text that will be input into an OCR 
(Optical Character Recognition) application; 
optionally uses the Text Enhancement 
Technology feature

Copy & Fax For text and graphic image in one document 
that you intend to copy or fax; uses the Auto 
Area Segmentation feature

To view the default 
settings for the Image 
Type you selected, 
click the Image Type  
button.

You can also change 
the settings for these 
options or save your 
own custom Image 
Types. See 
Customizing Image 
Types for more 
information.



Advanced Scanning Page 26

3 Now select the output device where you want to display or print your 
scanned image from the Destination list. These destinations 
automatically select resolution and sharpness settings appropriate for 
the output device. Select one of the following options:

The default resolution setting set by the Destination you choose is 
based on the Image Type you selected in step 2. 

Setting Type of output device

Screen/Web For viewing on a monitor screen or web page

EPSON printer For printing on your EPSON ink jet printer

Laser Printer For printing on a laser printer

Fax For sending to a fax machine or fax/modem

OCR For sending to an OCR (Optical Character 
Recognition) application

To view the default 
settings for the 
Destination you 
selected, click the 
Destination button.

You can also change 
the settings for these 
options or save 
your own custom 
destinations. See 
Customizing 
Destination Settings 
for more information.
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4 The Image Type and Destination settings you choose automatically 
select the correct Resolution setting for your image. 

If you need to change the resolution, click Advanced  to open the 
Advanced window, if necessary. Then select a new setting from the 
Resolution list. The available resolutions range from 50 to 9600 dpi. 
You can also type in a specific Resolution setting, such as 1600 or 
2400 dpi for enlargements, if it’s not in the list. 

If you enlarge your target image size by scaling or by selecting a larger 
Target size, be sure to increase the Resolution setting by the same 
proportion to retain your image quality. See Adjusting Source and 
Target Image Sizes for more information.

For additional information on selecting resolution, see your Scanner 
Basics book.

5 It’s a good idea to preview your image before you actually scan so you 
can make any necessary changes. To preview your image, click 
Advanced  to open the Advanced window, if necessary. Then see 
Previewing Your Scan for preview instructions. 

See Advanced Scanning for information on the rest of the TWAIN 
settings in the window.

6 When you’re ready to scan, click the Scan  button. The scanned image 
appears in your application window.

7 Click the Close  button to close the EPSON TWAIN window and return 
to your application.

To modify or save your scanned image using your application software, 
see your software documentation.

With applications that 
let you select ICM, 
sRGB, or ColorSync 
profiles for your 
printer, you’ll get great 
printed output when 
you scan using 
ICM/sRGB 
(Windows 98), or 
ColorSync 
(Macintosh). See 
Configuring Preview 
and Color Options for 
details.
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Scanning with the Auto Document Feeder
When you scan with the optional auto document feeder (ADF) installed, 
you need to select the correct basic settings in EPSON TWAIN. Before 
you begin, make sure you’ve installed the ADF and loaded your single- or 
multi-page document into it, as shown below. See your Scanner Basics 
book for more details.

Follow these steps to scan with the ADF and EPSON TWAIN:

1 Select the ADF (Windows) or Auto Document Feeder  (Macintosh) 
option in the Document Source list. You see a message telling you to 
make sure there is no document on the scanner’s document table. 
Ensure there is no document on the document table and click OK.

The maximum page 
size using the ADF is 
Legal size(8.5 × 11 
inches). 

The minimum size is 
3.35 × 5 inches.
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2 Select the correct Image Type setting for your document as described 
in the table below. For example, if you’ll be using an OCR (Optical 
Character Recognition) application to process your scanned 
document, select the OCR setting.

Setting Type of image 

Color Photo For color photographs

256 Colors For 256 color images, such as presentation 
graphics you’ll be displaying on a computer 
monitor

Black & White Photo For black and white photographs

Line Art For black line drawings

OCR For black text that will be input into an OCR 
application; optionally uses the Text 
Enhancement Technology feature

Copy & Fax For text and graphic images in a document that 
you intend to copy or fax; uses the Auto Area 
Segmentation feature

If you’re scanning 
an original on the 
scanner’s document 
table with the optional 
auto document feeder 
installed, select 
Flatbed  as the 
Document Source 
option; see Selecting 
Basic Settings for 
instructions.

For more information 
on the Image Type 
setting, see 
Customizing Image 
Types.



Advanced Scanning Page 30

3 Now select the output device where you want to display or print your 
scanned image from the Destination list. These destinations 
automatically select resolution and sharpness settings appropriate for 
the output device. Select one of the following options:

4 The Image Type and Destination settings you choose automatically 
select the correct Resolution setting for your document. If you set 
these options to OCR, the Resolution is set to 300 dpi; change the 
Resolution setting to 400 dpi  for best results.

Setting Type of output device

Screen For viewing on a monitor screen

Screen Vivid For viewing on a monitor screen with added 
sharpness

EPSON printer For printing on your EPSON ink jet printer

Laser Printer For printing on a laser printer

Fax For sending to a fax machine or fax/modem

OCR For sending to an OCR application

For more information 
on the Destination 
setting, see 
Customizing 
Destination Settings.
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If you need to change the resolution, click Advanced  to open the 
Advanced window, if necessary. Then select a new setting from the 
Resolution list. The available resolutions range from 50 to 9600 dpi. 
You can also type in a specific Resolution setting, if it’s not in the list. 

For additional information on scanning resolution, see your Scanner 
Basics book.

5 You must preview the first page of your document and set the correct 
page size. To preview your image, click Advanced  to open the 
Advanced window, if necessary. Then click the Preview button.

The scanner feeds the first (or only) page of your document into the 
ADF and prescans it. The prescanned image appears in the EPSON 
TWAIN preview image area. When the ADF ejects the first (or only) 
page, reload it in the ADF on top of your document.

6 To set the page size for your document and crop out the rest of the 
document table, click the Auto Locate button. A marquee appears 
around the page image and the Target width and height are set 
automatically. See Adjusting Source and Target Image Sizes for 
details.

With applications that 
let you select ICM, 
sRGB, or ColorSync 
profiles for your 
printer, you’ll get great 
printed output when 
you scan using 
ICM/sRGB 
(Windows 98) or 
ColorSync 
(Macintosh) mode. 
See Configuring 
Preview and Color 
Options for details.
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7 Click the Scan  button. You see this dialog box:

Click Single Page  (to scan a single page) or All Pages  (to scan a 
multi-page document). Then click OK .

8 EPSON TWAIN scans the document. If you’re scanning a multi-page 
document, it scans and loads one page at a time. When scanning is 
finished, close the EPSON TWAIN window. A scanned image of each 
(or your only) page appears in your application window.

9 Now you can follow the instructions in your application documentation 
to process your files as necessary. 
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Customizing Image Types
You can change the settings for the predefined Image Type options in 
EPSON TWAIN or add new image types. Click the Image Type  button in 
the Advanced window. You see the Image Type dialog box:

To change the settings of one of the predefined image types, select it 
from the Image Type Name list, change the settings, and click Save.

To create a new image type, select a predefined type with similar settings 
from the Image Type Name list. Then type a name for your new image 
type in the box at the top of the list. Change the settings as necessary and 
click Save.

To delete an image type, select it in the Image Type Name list and click 
Delete .

predefined 
image types

settings
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The table below describes the Image Type settings.

Image Type setting Options Description

Pixel Depth 24-bit Color For 24-bit color images

8-bit Gray For 8 bits/pixel images in 256 gray shades

Black & White For 1 bit/pixel black and white images

Halftone* None Lets the data format of your image 
determine the tone

Mode A (Hard tone) Converts the image into a hard toned 
distinct image of 1 and 2 bits/pixel/color

Mode B (Soft tone) Converts the image into a softer tone for 
images with large areas of similar tones 
(1 bit/pixel/color)

Mode C (Net Screen) Represents images in net screen, similar 
to newspaper photographs 
(1 bit/pixel/color)

Dither A (4 × 4 Bayer) Represents images in a 4 × 4 Bayer dither 
pattern

Dither B (4 × 4 Spiral) Represents images in a 4 × 4 spiral dither 
pattern

Dither C (4 × 4 Net screen) Represents images in a 4 × 4 net screen 
dither pattern

Dither D (8 × 4 Net screen) Represents images in an 8 × 4 net screen 
dither pattern
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* Available only when the Pixel Depth setting is set to Black & White .

** Available only when the Pixel Depth setting is set to 8-bit Gray  or Black & White .

Dropout** None Includes all color values in a monochrome 
scan

Red Scans red areas as white so they don’t 
appear in a monochrome scan 

Green Scans green areas as white so they don’t 
appear in a monochrome scan

Blue Scans blue areas as white so they don’t 
appear in a monochrome scan

Scanning Draft Scans faster at a lower resolution for drafts

Best Scans at the highest quality

De-screening On Automatically removes printing patterns 
from printed materal

Off —

B/W Option* (Windows)
Black and White 
Options* (Macintosh)

None Selects no black and white scanning options

Text Enhancement 
Technology

Improves text recognition accuracy and 
removes the document background when 
performing OCR (Optical Character 
Recognition) scanning

Auto Area Segmentation Separates text from graphics when scanning 
pages containing text and grayscale images 
for more accurate text recognition

Image Type setting Options Description
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Customizing Destination Settings
You can change the settings for the predefined Destination (output 
device) options available in EPSON TWAIN or add new Destination 
options of your own. 

Click the Destination  button in the EPSON TWAIN window. You see the 
Destination dialog box:

To change the settings of one of the predefined destinations, select it 
from the Destination Name list, change the settings, and click Save.

To create a new destination, type a name for it in the box at the top of the 
list. Change the settings as necessary and click Save.

To delete a destination, select it in the Destination Name list and click 
Delete . 

predefined 
destinations

settings
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The resolution and sharpness settings for each of the predefined 
Destination options are listed in the table below:

The default resolution settings set by the Destination option are based on 
the Image Type you select:

◗ If you selected Color Photo  or Black & White Photo  as the Image 
Type setting, the resolution listed in the Photo Resolution column is 
used

◗ If you selected Line Art , OCR, or Copy & Fax as the Image Type 
setting, the resolution listed in the Drawing/Halftone Resolution column 
is used.

Destination options
Drawing/Halftone 
Resolution Photo Resolution

Screen/Web 96 96

EPSON ink jet printer 360 to 720 150 to 360

Laser Printer 600 200

Fax 200 200

OCR 300 300

You can change the 
Resolution setting on 
the EPSON TWAIN 
main window if you 
don’t want to use the 
default resolution set 
by the Destination 
option.
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Adjusting Source and Target Image Sizes
The Source width and height fields indicate the size of the entire preview 
image or of the marquee. You can type in a new width and height to 
specify exactly how much of the image you want to scan. 

To change the unit of measurement used for the Source and Target width 
and height fields, select inches , pixels , or cm  (centimeters) from the 
measurement units list.

The Target width and height fields indicate the size of your scanned 
image using the current settings. The values in these fields change as 
you modify settings. You can also type in a specific width and height to 
specify the target image size exactly.

To retain the Target width and height no matter how you size the source 
image, click the lock icon. Click it again to unlock the values. The file size 
indicator shows the approximate size of the scanned image in KB or MB, 
based on the image’s size and selected resolution.

Sometimes the 
values you select 
may be rounded up or 
down to retain the 
proportions of your 
image or marquee.
The width and height 
settings are ignored if 
you scan without first 
previewing the image.

If you enlarge your 
target image size by 
scaling or selecting a 
larger Target size, be 
sure to increase the 
Resolution setting by 
the same proportion 
to retain your image 
quality. See Selecting 
Basic Settings for 
instructions on 
changing the 
Resolution setting.

measurement units

file sizelock icon
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Scaling the Image 
The Scale field indicates the amount by which an image is enlarged or 
reduced during scanning.

You can adjust the scale by moving the slider box, clicking the left or right 
arrow, or typing a percentage in the Scale field.

Using Automatic Adjustment Features
EPSON TWAIN includes two automatic adjustment features to help you 
quickly prepare your preview image for scanning, as described in these 
sections:

◗ Using Auto Exposure

◗ Using Auto Locate

The range of the 
possible scale values 
depends on the 
Resolution setting.

If you enlarge your 
target image size 
by scaling it, be sure 
to increase the 
Resolution setting by 
the same proportion 
to retain your image 
quality. See Selecting 
Basic Settings for 
instructions on 
changing the 
Resolution setting.
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Using Auto Exposure
Click the Auto Exposure button in the Advanced window to 
automatically adjust the image exposure. Auto Exposure sets the 
Exposure, Highlight, Gamma, and Shadow settings in the Image Controls 
dialog box automatically. See Adjusting Image Controls for details.

Using Auto Locate
After previewing your image, click the Auto Locate button in the 
Advanced window to crop out everything on the document table except 
your image.
 

Auto Exposure is 
automatically enabled 
when you scan from 
the Easy window. 
Auto Locate is 
automatically enabled 
if you click the Scan 
button without 
previewing the image, 
unless you’re 
scanning with the 
ADF and Text 
Enhancement 
Technology is turned 
on (see Customizing 
Image Types for 
details on the Text 
Enhancement 
Technology feature).

Auto Locate button
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If the document table contains more than one image, select the target 
image by dragging the mouse pointer across it to create a rough marquee 
(see Using Marquees for instructions). Then click the Auto Locate 
button. The marquee is placed exactly around the target image borders 
automatically.

Auto Locate button

target image
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Adjusting Image Controls
Use the Image Controls to adjust the following settings:

◗ Exposure

◗ Gamma

◗ Highlight

◗ Shadow

◗ Threshold

Click the Image Controls button in the Advanced window to display 
the Image Controls dialog box:

To change the Image Controls, move the slider for the setting, click the 
left or right arrows, or type a value in the field on the right. See Using the 
Color Buttons for instructions on using the color buttons.

Auto Exposure 
overrides any Image 
Controls setting you 
select.

You can’t use the 
Image Controls when 
Text Enhancement 
Technology is turned 
on (see Customizing 
Image Types for 
details).

setting fields 
and sliderscolor 

buttons
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The Image Controls settings are described in the table below.

* The Threshold setting is available only when the Pixel Depth setting is set to 
Black & White  and the Halftone setting is set to None . When the Threshold 
setting is active, the rest of the Image Controls are not available.

Image Controls* Description

Exposure Sets the intensity of light in the image as determined 
by a combination of the Highlight  and Shadow  
settings from –10 (darkest) to 20 (brightest)

Gamma Sets the amount of contrast in your image from 
50 (lowest) to 500 (highest)

Highlight Sets the amount of detail visible in the brightest 
areas of the image from 61 (lightest) to 490 (darkest) 

Shadow Sets the amount of detail visible in the darkest areas 
of your image from 0 (lightest) to 60 (darkest)

Threshold Sets the point at which the gray image areas are 
scanned as either black or white from 0 (lightest) to 
255 (darkest) 
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Using the Color Buttons
You can use the Highlight and Shadow color buttons to select particular 
colors in the image for use as the highlight and shadow colors. Click a 
color button and move the mouse pointer over the preview image; the 
pointer changes to an eyedropper icon. Then click on a color that you 
want to use as the highlight or shadow color for the entire image. The 
color box beneath the setting turns to that color.

Using Tone Correction
You can use Tone Correction to change the pixel brightness in the 
midtones, highlights, and shadows of an image. This produces more 
detail in the image without dramatically changing it. Click the Tone 
Correction button in the Advanced window to display the Tone Correction 
dialog box.

You can’t use Tone 
Correction when the 
Pixel Depth is set to 
Black & White, 
Halftone is set to 
None, or Text 
Enhancement 
Technology is turned 
on (see Customizing 
Image Types for 
details).

Output 
checkboxes 
and fields

tone curve

Channels 
buttons

tone correction 
types list
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Each point on the tone curve represents the Output checkbox 
characteristic to its right. For example, the top point on the curve 
represents the Highlight characteristic. 

In addition, the Channels radio buttons indicate the color(s) that the tone 
curve will modify: red, green, blue, or all three colors.

Once you’ve selected the color you want to modify using the Channels 
buttons, use these methods to change the tones:

◗ Drag points on the tone curve to adjust the tone value. 

◗ Select a predefined group of settings from the tone correction type list. 
Select Linear , Lighten , Darken , Flat Contrast , High Contrast , or 
Open Shadow . You can also create your own custom tone correction 
settings, as described below.

◗ Type a value in the field for an Output setting (the range of acceptable 
values varies for each setting). To lock a setting in place so it’s 
unaffected by changes in other settings, click its checkbox. The setting 
will not change unless you drag its point on the tone curve. 

Customizing Tone Correction Settings
To save a custom tone correction setting, first make the changes on the 
Tone Correction dialog box. The tone correction setting in the list changes 
to User Defined . Change the name in the list box to the one you want to 
use for your custom setting. Then click Save.

To delete a setting, select its name in the tone correction list and click 
Delete . 
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Using Color Adjustments
You can adjust the Gray Balance Intensity  and Saturation  of colors in a 
color image using the Color Adjustment tools.

Click the Color Adjustment button in the Advanced window to display 
the Color Adjustment dialog box:

Color Adjustment 
settings are disabled 
if you click the Scan  
button without 
previewing the image.

You can’t use Color 
Adjustment if the Pixel 
Depth is set to 8-bit 
Gray  or Black & White 
(see Customizing 
Image Types for 
details).
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Changing the Gray Balance Intensity
The Gray Balance Intensity  setting adjusts the gray tones in the image 
to appear more neutral. You may need to adjust this setting if the three 
colors that are mixed together to form the neutral gray are unbalanced. 
For example, if a photograph has an undesirable green color cast caused 
by fluorescent lighting, you can select a greenish area in the photo and 
adjust the intensity to achieve the correct colors.

To change the Gray Balance Intensity, follow these steps:

1 First click the eyedropper button and move the mouse pointer onto 
your preview image. The mouse pointer changes to an eyedropper 
icon.

2 Select a color that you want removed from the neutral gray tones in the 
preview image. The original and corrected colors appear in the boxes 
beside the eyedropper button.

3 Adjust the gray level (from 0 to 100) by moving the slider, clicking the 
left or right arrow, or typing a value in the field on the right. 

Changing the Saturation
Changing the saturation level of colors increases or decreases the 
amount of color in each hue. Less saturated colors are more pale, while 
saturated colors are richer.

Adjust the saturation level from –100 (less saturated) to 100 (more 
saturated) by moving the slider, clicking the left or right arrow, or typing a 
value in the field on the right.
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Saving Custom Settings
You can save a custom set of all the EPSON TWAIN settings for your 
scan so you can easily select it when you perform a similar scan later. 
You can even save different settings for the same image or marquee and 
scan all of them at once; see Batch Scanning for details.

Click the Settings  button in the Advanced window to display the Settings 
dialog box:

The currently selected EPSON TWAIN settings are listed on the right. 
To create a custom setting group, type a name for the group to replace 
the name User Defined  at the top of the list. Then click Save. 

Whenever you want to use the setting group for a scan, click Settings , 
select its name, and click OK.

To delete a custom setting group, click its name in the list; then click 
Delete .

current 
settings

User defined 
settings list
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Batch Scanning
To quickly scan one image or marquee with a variety of different settings, 
you can perform a batch scan. Follow these steps:

1 Create and save each group of settings you want to scan with, giving 
each a unique name, as described in Saving Custom Settings. 

2 In the Settings dialog box, highlight all the settings you want to include 
in the batch scan using the Shift  or Ctrl  (Windows only) keys. 

3 Click the Batch Scan  button. 

TWAIN scans the image once for each setting group and loads the 
scanned images separately into your application software.

Some applications 
don’t support batch 
scanning or must 
have multiple image 
support turned on to 
support batch 
scanning. Check 
your application 
documentation to see 
if it supports batch 
scanning before using 
this feature.

highlight 
settings for the 
batch scan

click the Batch 
Scan button
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Configuring Preview and Color Options
You can configure EPSON TWAIN’s preview and color options so they 
work the way you want whenever you use the program. Click the 
Configuration  button to display the Configuration dialog box:

To automatically save the preview image and all the scanning settings 
when you preview, scan, or close TWAIN, click the Save Preview Image 
and Settings  checkbox.

Click the Fast Preview  checkbox to enable high-speed loading of the 
preview image in draft mode (the quality will not be as good as a normal 
preview).

To automatically preview an image whenever you start EPSON TWAIN, 
click the Automatic Preview  checkbox.

Windows Macintosh
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To automatically adjust the exposure each time you preview, click the 
Auto Exposure on Preview  checkbox. See Using Auto Exposure for 
details. If you select the ICM/sRGB  (Windows 98/NT 4.0) or ColorSync  
(Macintosh) checkbox, you can’t change the current Auto Exposure on 
Preview  setting. 

If you’re using applications that let you select color management profiles 
for your printer, you’ll get great printed output when you scan your images 
using either ICM/sRGB  (Windows 98/NT 4.0) or ColorSync  (Macintosh) 
to reproduce colors more closely. (To use ICM/sRGB , the Pixel Depth 
setting of your selected Image Type must be 24-bit Color ; see 
Customizing Image Types for details.) 

With ColorSync select either Perceptual  (for photographs), Colorimetric  
(for spot color images), or Saturation  (for charts and graphs). 

To successfully scan 
with ICM/sRGB or 
ColorSync, you must 
also set up that color 
management system 
for your monitor and 
printer. See your 
operating system 
documentation for 
instructions. You 
should also use 
devices and software 
compatible with your 
color management 
system.
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Using the EPSON TWAIN
Utilities

These sections give instructions for using the utilities installed along with 
EPSON TWAIN to help you scan and calibrate your system:

◗ Using the Scanner Monitoring Utility

◗ Using the EPSON Screen Calibration Utility

◗ Using EPSON Scan! II

Using the Scanner Monitoring Utility
When you installed EPSON TWAIN on your system, the installer 
automatically installed one of these scanner monitoring utilities:

◗ Scan Events monitor in the Scanners and Cameras Control Panel 
(Windows 98)

◗ EPSON Scanner Monitor (Macintosh)

The scanner monitoring utilities let you use one-touch scanning with the 
scanner’s Start button and the Presto! PageManager software. If you 
installed PageManager when you installed your scanner software, see 
Using the Start Button for instructions on using your scanner monitoring 
utility.
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Using the EPSON Screen Calibration Utility
When you installed EPSON TWAIN on your system, you calibrated your 
screen at the end of the installation sequence. If you ever change your 
monitor or want to re-calibrate your screen, you can run the EPSON 
Screen Calibration utility again. Calibrating your screen improves the 
accuracy of your preview images in EPSON TWAIN.

Follow the instructions for your operating system in these sections:

◗ Calibrating the Screen with Windows

◗ Calibrating the Macintosh Screen

Calibrating the Screen with Windows
Follow these steps to calibrate your screen:

1 Click Start , point to Settings , and click the Control Panel  icon.

2 Click the Scanners and Cameras (Windows 98) or EPSON TWAIN 4 
(Windows 95/NT) icon. Windows 95/NT users should skip ahead to 
step 5; Windows 98 users see this dialog box:

Devices tab

scanner name

Properties button
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3 If necessary, click the Devices  tab. Click your scanner name in the 
box, then click the Properties  button.

4 On the next screen, click the Utility  tab. You see this dialog box:

5 Click the Screen Calibration Utility  button. You see the following:

Utility tab

Screen Calibration 
Utility button

View the screen from 
a short distance when 
you calibrate it. The 
gray stripes won’t 
blend perfectly 
together; however, try 
to make them match 
as closely as 
possible. before calibration after calibration



Using the EPSON TWAIN Utilities Page 55

6 Click and drag the slider box or click the left or right slider arrows until 
the shades of the gray stripes match as closely as possible.

7 Click OK . The profile is saved as the Screen  Destination setting in 
EPSON TWAIN.

8 Click OK  at all the open windows to close them and return to the 
Control Panel.

Calibrating the Macintosh Screen
Follow these steps to calibrate your screen:

1 Open the EPSON Scanner folder and select EPSON Screen 
Calibration . You see the following dialog box:

2 Click and drag the slider box or click the left or right slider arrows until 
the shades of the gray stripes match as closely as possible.

3 Click OK . The profile is saved as the Screen  Destination setting in 
EPSON TWAIN.

View the screen from 
a short distance when 
you calibrate it. The 
gray stripes won’t 
blend perfectly 
together; however, 
try to make them 
match as closely as 
possible.

before calibration after calibration
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Using EPSON Scan! II
EPSON Scan! II is a TWAIN-compliant application supplied with EPSON 
TWAIN (Macintosh only) in case you choose not to install Presto! 
PageManager, Adobe PhotoDeluxe, or another TWAIN-compliant 
program for scanning. For best results, however, scan with one of the 
TWAIN-compliant applications that came with your scanner instead of 
EPSON Scan! II.

Before scanning, make sure you’ve installed the EPSON TWAIN software 
(as described in the Scanner Basics book).

These sections tell you how to use EPSON Scan! II:

◗ Scanning with EPSON Scan! II

◗ Exporting Images with EPSON Scan! II

Scanning with EPSON Scan! II
Follow the steps in this section to scan using EPSON TWAIN with 
EPSON Scan! II. 

1 Make sure you’ve set up and turned on the scanner, and placed the 
document you want to scan on the document table. See the Scanner 
Basics book for instructions.

2 To start EPSON Scan! II, select the EPSON Scan! II  icon in the 
EPSON Scanner  folder.

If you start EPSON 
Scan! II before turning 
on your scanner, the 
software may not 
work properly.
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3 Select your scanner source. Open the File menu and choose Select 
Source .

4 Select EPSON TWAIN 4 and click Select .

5 Open EPSON TWAIN for scanning. Choose Acquire  from the File 
menu.

You usually need to 
perform steps 3 and 4 
only once, when you 
use your scanner and 
EPSON Scan! II for 
the first time.

Click to select the 
scanner source
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One of the EPSON TWAIN windows appears.

For instructions on selecting EPSON TWAIN settings, see Selecting 
Basic Settings and Advanced Scanning.

6 When you’re ready to scan, click the Scan  button. The scanned image 
appears in your EPSON Scan! II window.

7 Click the Close  button to close the EPSON TWAIN window to return to 
EPSON Scan! II.

8 To export your image in a format your image-editing application can 
read, see Exporting Images with EPSON Scan! II. 

To use any other program features, see Using Other EPSON Scan! II 
Features.

Advanced window

Easy window 
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Exporting Images with EPSON Scan! II
EPSON Scan! II can save your scanned images in two ways:

◗ saved in its original format that cannot be opened by other applications

◗ exported into one of a variety of standard formats that can be opened 
by other applications

Most of the time, you’ll want to export any images you scan with EPSON 
Scan! II so you can open them in an image-editing or desktop publishing 
program for use in your documents. If you save them in EPSON Scan! II’s 
original format, you can open them with EPSON Scan! II only.

You can export images into any of the formats described in the table 
below.

You can open only 
EPSON Scan! II 
original format files in 
EPSON Scan! II; you 
cannot open any 
other file formats.

Export file format Description

TIFF 5.0 (*.TIF) Standard Tagged Image File Format version 5.0; for exporting 
black and white images with G3 compression

EPS (*.EPS) Encapsulated PostScript format

TIFF 6.0 (JPEG) (*.TIF) Tagged Image File Format version 6.0; for exporting 16-million 
color or 256-gray level images with JPEG compression

JPEG (*.JPG) Joint Photographic Experts Group format; for exporting 16-million 
color or 256-gray level images with data compression

PICT Standard QuickDraw™ picture format; for exporting black and 
white images with G3 compression and 16-million color or 
256-gray level images with JPEG compression
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You can export an image you already scanned into EPSON Scan! II or 
you can use the Acquire and Export option, which lets you scan and 
export in one step. See the instructions in these sections:

◗ Exporting Scanned Images

◗ Acquiring and Exporting

Exporting Scanned Images
1 Start EPSON Scan! II and scan your image as described in Scanning 

with EPSON Scan! II.

2 In the EPSON Scan! II window, select Export  from the File menu. You 
see the Export dialog box.

3 Select the drive and folder to which you want to export the file.

4 Select the format you want to use in the Export File Format list.

5 Type a name for the file in the Export image as list.

6 Click Export . The image is exported and you return to the EPSON 
Scan! II window.
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Acquiring and Exporting
To scan and export an image in one operation, follow these steps:

1 Start EPSON Scan! II as described in Scanning with EPSON Scan! II.

2 Select Acquire & Export  from the File menu. You see one of the 
EPSON TWAIN windows. For instructions on selecting EPSON 
TWAIN settings, see Selecting Basic Settings and Advanced 
Scanning.

3 When you’re ready to scan, click the Scan  button. You see the Export 
dialog box.

4 Select the drive and folder in which you want to export the file.

5 Select the format you want to use in the Export File Format list.

6 Type a name for the file in the Export image as list.

7 Click Export . EPSON Scan! II scans and then exports the image.

8 Close the EPSON TWAIN window and return to the EPSON Scan! II 
window.
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Using Other EPSON Scan! II Features
EPSON Scan! II also provides features for viewing images and copying 
them into other applications, as described in the sections below.

Using the View Features
To modify the view of your image in the EPSON Scan! II window, open 
the View menu. 

Select the All Dots[1:1]  option if you want each dot (pixel) in your image 
represented by one dot on your screen. The higher the resolution of your 
image, the larger it appears on the screen.

Select the Fit in Window  option if you want to adjust the view of the 
image so it fits into the EPSON Scan! II window. The smaller the window 
size, the smaller the image appears. This option centers the image in the 
window if the window is larger than the scanned image.
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Copying Images
You can copy all or a portion of a scanned image in EPSON Scan! II and 
then paste it into another application. Follow these steps:

1 To select the entire image area for copying, open the Edit menu and 
choose Select All . You see a dotted line around the image.

To select a portion of the image, click in the image and drag a box 
around the area you want to copy. You see a dotted line around the 
area you selected.

(To delete the box, click anywhere in the image.)

2 Open the Edit menu and select Copy .

3 Open the application program you want to paste your image into, then 
open the document in which you want the image to appear.

4 Select Paste  (or another command as necessary). The image appears 
in your document.
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Using the Start Button

The scanner’s Start button lets you set up your system for one-touch 
scanning with Presto! PageManager and a scanner monitoring utility. 
With one-touch scanning, you can load a document in the scanner, press 
the Start button, and watch while PageManager starts and then opens 
EPSON TWAIN automatically. You can even set up PageManager to 
automatically load your scanned document into another application—
such as PhotoDeluxe—or send it to another device—such as your 
printer.

Preparing to Use the Start Button
To use the Start button, you must have installed PageManager (see the 
Scanner Basics book for installation instructions). With Windows 98, you 
can also use other programs that support linking to scanner events with 
the Start button, such as Photoshop 5.0 and Windows Imaging. Then you 
must enable scanner monitoring and configure PageManager (or another 
compliant application) to handle your scanned images.

Follow the instructions in these sections to set up Start button scanning:

◗ Enabling Scanner Monitoring

◗ Setting Up PageManager for Start Button Scanning

When you’re ready to use the Start button, follow the instructions in 
Scanning with the Start Button.
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Enabling Scanner Monitoring
When you installed EPSON TWAIN on your system, the installer 
automatically installed the TWAIN utilities, including these scanner 
monitoring utilities:

◗ Scan Events monitor in the Scanners and Cameras Control Panel 
(Windows 98)

◗ EPSON Scanner Monitor (Windows 95 and NT 4.0)

◗ EPSON Scanner Monitor (Macintosh)

These utilities let your scanner’s Start button communicate with your 
operating system and open PageManager (or another Windows 98 Start 
button compliant program).

Follow the steps in these sections to enable scanner monitoring:

◗ Setting Up Monitoring for Windows 98

◗ Setting Up Monitoring for Windows 95 and Windows NT 4.0

◗ Setting Up Monitoring for Macintosh
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Setting Up Monitoring for Windows 98
The Scan Events monitor installed into the Windows Scanners and 
Cameras Control Panel is automatically enabled and ready to scan to 
PageManager (and any other Start button compatible programs) when 
you press the Start button.

If you ever want to disable (or enable) Start button scanning, follow these 
steps:

1 Click Start , point to Settings , and click the Control Panel  icon.

2 Click the Scanners and Cameras  icon. You see this dialog box:

3 If necessary, click the Devices  tab. Click your scanner name in the 
box, then click the Properties  button.

Devices tab

scanner name

Properties button
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4 Click the Events  tab. You see this dialog box:

5 To disable Start button scanning, click the Disable device events  
checkbox; a check appears in the checkbox.

To enable Start button scanning, click the Disable device events  
checkbox to uncheck it. Then click the checkbox for each application 
you’d like to be able to use with the Start button. If you select more 
than one application, you’ll be prompted for the application you want to 
use when you press the Start button.

6 Click OK .

Disable device 
events checkbox
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Setting Up Monitoring for Windows 95 and Windows NT 4.0
The EPSON Scanner Monitor installed with EPSON TWAIN on the PC is 
automatically enabled and set up to scan with PageManager when you 
press the Start button. 

If you want to disable the EPSON Scanner Monitor for the current 
computing session, do the following:

1 Right-mouse-click the green  EPSON Scanner Monitor icon from 
the Windows Taskbar (located next to the clock).

2 Choose Close  from the pop-up menu. 

To enable monitoring, do the following:

1 From the Windows desktop, click Start  > Programs  > EPSON 
Scanner  > EPSON Scanner Monitor .

You may see a dialog box momentarily appear as EPSON Scanner 
Monitor establishes communication with the scanner.

2 The EPSON Scanner Monitor  icon appears on the Windows Taskbar, 
next to the clock.

To stop EPSON 
Scanner Monitor from 
loading every time you 
start Windows, 
remove the EPSON 
Scanner Monitor icon 
from your Startup 
folder in the Start 
menu.
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Setting Up Monitoring for Macintosh
The EPSON Scanner Monitor installed with EPSON TWAIN on the 
Macintosh is automatically enabled and set up to scan with PageManager 
when you press the Start button. 

If you ever want to disable the EPSON Scanner Monitor, do the following:

1 Select EPSON Scanner Monitor Setup  from the Apple menu; you see 
the EPSON Scanner Monitor dialog box. 

2 Click the Enable Monitoring  checkbox to uncheck it.

3 Click OK .

To enable monitoring, do the following:

1 Select EPSON Scanner Monitor Setup  from the Apple menu; you see 
the EPSON Scanner Monitor dialog box.

2 Click the Enable Monitoring  checkbox to check it.

3 Click OK .
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Setting Up PageManager for Start Button Scanning
To use PageManager with your scanner’s Start button, you must set up 
PageManager’s Scan Buttons palette and assign a destination program 
or device to the Start button. For example, if you want the images you 
scan to be sent directly to your image editing program, you can assign the 
Start button to PhotoDeluxe (or another image editing program). 

The Scan Buttons palette appears on the screen whenever PageManager 
is running so you can select the destination program or device for your 
scanned images. (If it doesn’t appear, open the View menu and click the 
Scan Buttons  option.)

The icon that contains the 

 

] Start button icon indicates where images 
scanned using the Start button will be sent. (You can select 
PageManager as the destination program for your scanned images if you 
don’t want them to load into a different program.) 

Follow the instructions in these sections to set up the Scan Buttons:

◗ Assigning a Destination to the Start Button

◗ Adding a Destination to the Scan Buttons Palette

◗ Reassigning Destinations on the Scan Buttons Palette

◗ Selecting Scan Button Settings

To set up other Start 
button compliant 
applications in 
Windows, see 
the application 
documentation for 
instructions.

The PageManager 
program icon on the 
Macintosh is different; 
it is shaped like a 
desktop inbox. See 
PageManager online 
help for details.

PageManager program 
icon with the Start button 
assigned to it
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Assigning a Destination to the Start Button
PageManager is the default destination program for the Start button. To 
assign another destination to the Start button, follow these steps:

1 Open the File menu and select Scan Buttons Setting . You see the 
Scan Buttons Setting dialog box. Click the Start Button Settings  tab.

2 To change the program or device assigned to the Start button, click its 
icon in the Select target application box.

3 If you want to automatically launch EPSON TWAIN within 
PageManager when you press the Start button, make sure the 
Execute Scan Button automatically  checkbox is checked. 

If you want to launch PageManager and display only the Scan Buttons 
palette when you press the Start button, click the Execute Scan 
Button automatically  checkbox to uncheck it. You’ll then need to click 
a button in the Scan Buttons palette to continue with your scan.

4 Click OK .

If you select a 
program or device for 
which you suppressed 
the TWAIN interface, 
be sure to set 
PageManager’s scan 
settings before you 
press the Start button. 
See Selecting Scan 
Button Settings for 
details.

select the icon for the 
program or device you 
want to assign to the 
Start button
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Adding a Destination to the Scan Buttons Palette
If you want to add program or device icons to the Scan Buttons palette, 
follow these steps:

1 Open the File menu and select Scan Buttons Setting . You see the 
Scan Buttons Setting dialog box. Click the Properties  tab, if 
necessary.

2 Click the Add  button. On the Macintosh, you see the Add scan button 
dialog box.

3 Click the arrow in the Scan to  (Windows) or Scan to App  (Macintosh) 
setting box. The Scan to setting lists the programs and devices on your 
system that PageManager can send your scanned file to. Select the 
program or device you want to add. An icon for it appears in the scroll 
bar on the left (Windows only).

Scan to 
setting list

Add button

Properties 
tab
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4 Type a name for the icon in the Name field. On a Macintosh, click OK 
to close the Add scan button dialog box.

5 If the Suppress TWAIN User Interface  checkbox is active, you can 
select whether you want PageManager to open the EPSON TWAIN 
dialog box when you press the Start button. 

If you don’t check the checkbox, the EPSON TWAIN dialog box 
appears after you press the Start button and PageManager opens. 
Then you can preview, select settings, and click Scan  when you’re 
ready.

If you check the checkbox, PageManager suppresses the EPSON 
TWAIN dialog box and uses the settings described in step 6.

6 If you checked the Suppress TWAIN User Interface  checkbox in 
step 5, the PageManager scan settings become active.

For the best results, 
don’t suppress the 
EPSON TWAIN 
interface when 
scanning with the 
Start button. This lets 
you preview and 
adjust your image 
settings the way you 
want them before you 
scan. You’ll also get 
a wider variety of 
setting choices than 
if you suppress 
TWAIN and use the 
PageManager scan 
settings.

active PageManager 
scan settings
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If these settings are active, select the scan settings you want to use 
whenever you press the program or device icon; see Selecting Scan 
Button Settings for details. 

7 If you want to assign a new destination program or device to the Start 
button, see Assigning a Destination to the Start Button for instructions.

8 When you’re finished adding programs or devices, click OK.

Reassigning Destinations on the Scan Buttons Palette
You may want to reassign an existing icon to a different program or 
device, or just change its settings. For example, if you use more than one 
printer, you may want to reassign the printer icon to each printer as you 
need it.

1 Open the File menu and select Scan Buttons Setting ; then click the 
Properties  tab, if necessary.

2 Click the icon for the program or device you want to reassign in the 
scroll bar on the left of the dialog box. The current properties for the 
icon appear to the right.

If you want to delete 
an icon from the Scan 
Buttons palette, 
select the icon in the 
scroll bar on the left 
of the dialog box and 
click the Remove  
button.

Properties tab

click the icon for the 
program or device you 
want to reassign

Scan to 
setting list
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3 To select a different program or device for the icon, choose it from the 
Scan to  (Windows) or the Scan to App  (Macintosh) setting list. 

4 If you checked the Suppress TWAIN User Interface  checkbox, 
change any of the active PageManager scan settings as necessary; 
see Selecting Scan Button Settings for details.

5 If you want to assign a new program or device to the Start button, see 
Assigning a Destination to the Start Button for instructions.

6 When you’re finished reassigning destinations, click OK.

Selecting Scan Button Settings
If you select a device or program for which you’ve checked the Suppress 
TWAIN User Interface  checkbox, the PageManager scan settings 
become active. If they’re active, select the options you want to use 
whenever you press the destination icon in the Scan Buttons palette or 
assign the Start button to the icon.

active PageManager 
scan settings
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The table below describes the settings and their available options.

Setting Options Description

Document Type
(Windows only)

Magazine (Text and Picture)
Magazine (Picture)
Photograph
Document
Letter
Business Card
Others 

Select the type of original you’re 
scanning so PageManager can 
choose the best default options 
for the rest of the settings. 
Select Others to customize a 
different document type.

Scan Mode Color
Gray
Black and White

Select the color specification of 
the original you’re scanning.

Scan Size Legal 8.5 × 14 inches
Letter 8.5 × 11 inches
A4 210 × 297 mm
B5 182 × 257 mm
A5 148 × 210 mm
Custom (Windows only)
3 × 5 (Landscape) [Macintosh only]
3 × 5 (Portrait) [Macintosh only]
4 × 6 (Landscape) [Macintosh only]
4 × 6 (Portrait) [Macintosh only]
5 × 7 (Portrait) [Macintosh only]
5 × 7 (Landscape) [Macintosh only]
Business Card (Macintosh only)

Select the size of the area you 
want to scan. When you select 
Custom (Windows only), you 
see a Customize Size dialog 
box; select the measurement 
unit, type in the Width and 
Height values, and then click 
OK.
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Resolution 72 300
100 360
150 400
200 600
240 800

Select the scanning resolution 
you want to use. You can’t type 
in a custom resolution.

Enable Document 
Feeder

On
Off

If you’re scanning with the 
optional auto document feeder, 
check the checkbox to turn this 
feature on.

Brightness –100 to 100 Adjust the brightness of the 
scan as necessary. This setting 
appears only when the Scan 
Mode is set to Color or Gray.

Contrast –100 to 100 Adjust the contrast of the scan 
as necessary. 

Threshold 0 to 255 Adjust the threshold for the 
highlights and shadows of the 
scan as necessary. This setting 
appears only when the Scan 
Mode is set to Black and White 
and replaces the Brightness 
setting.

Setting Options Description
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Scanning with the Start Button
Once you’ve set up your scanner monitoring utility and configured 
PageManager to handle your scanned images the way you want, you’re 
ready to scan with the Start button. 

The sequence of steps varies (as noted in the text), depending on 
whether you’ve elected to suppress the TWAIN interface or not, and 
whether you’ve set up PageManager to send your scanned images to 
another application or not. For details on these selections, see Setting Up 
PageManager for Start Button Scanning.

Because Start button scanning is most useful for scanning text 
documents into an OCR application, these steps use OCR scanning as 
an example. If you’re scanning photographs or other types of documents, 
see Selecting Basic Settings and Advanced Scanning for details on other 
TWAIN settings you may want to select.
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Follow these steps to scan with the Start button:

1 If you’re scanning a single page on the scanner’s document table, 
place the document face down and align its horizontal and vertical 
edges with the scales on the top and right side of the document table.

If you’re using the auto document feeder to scan a multi-page 
document, load your document face up with the first page on top of the 
document. Make sure the top of the page faces into the feeder.

2 Press the scanner’s Start button.

scanning multiple pages 
with ADF installed

scanning single pages

Start button
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3 In Windows, if you’ve selected more than one application to use with 
the Start button in the Scan Events utility, you see this dialog box:

Click Presto! PageManager for EPSON  and click OK. (If the dialog 
box disappears before you select an application, press the scanner’s 
Start button again.)

4 If PageManager wasn’t running when you pressed the Start button, 
PageManager starts on your system.

If you suppressed the TWAIN interface, the scanner begins scanning 
your document. Go to step 10.

For instructions on 
changing the 
applications available 
for use with the Start 
button, see Enabling 
Scanner Monitoring.

If you suppressed the 
TWAIN interface, you 
must have set the 
correct scan settings 
in the PageManager 
Scan Button Settings 
dialog box to scan 
successfully. See 
Setting Up 
PageManager for 
Start Button 
Scanning for details.
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If you didn’t suppress the TWAIN interface, the EPSON TWAIN Easy 
or Advanced window opens in PageManager, along with the Scan 
Buttons bar. Go to step 5.

5 To scan a document for an OCR application, select the following 
settings in EPSON TWAIN:

Document Source :
Select Flatbed  to scan a document on the document table. 
Select ADF (Windows) or Auto Document Feeder  (Macintosh) to 
scan a document from the ADF.

Image Type  and Destination :
Select OCR for both settings.

Resolution :
Select 400 dpi for the best OCR results.

(If you’re scanning a different type of document, select the settings for 
it as necessary. See Selecting Basic Settings for more information.)

Advanced window

Easy window 
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6 Click the Preview button to prescan the image. (If you’re using the 
Easy window, click Advanced  to open the Advanced window.)

If you’re scanning from the document table, EPSON TWAIN prescans 
the page. 

If you’re using the ADF, EPSON TWAIN loads the first page and 
prescans it. When the ADF ejects the first page, reload it in the ADF on 
top of your document with the top edge facing into the feeder.

7 Click the Auto Locate button to set the page size for your scan and 
crop out the rest of the document table.

8 Click the Scan  button to scan your document. If you’re scanning from 
the document table, go to step 10.

9 If you’re scanning with the ADF, you see this dialog box:

Click Single Page  (to scan a single page) or All Pages  (to scan a 
multi-page document). Then click OK .

10 EPSON TWAIN scans the document. If you’re scanning a multi-page 
document, it scans and loads one page at a time. When scanning is 
finished, click the Close  button to close the EPSON TWAIN window. (If 
you suppressed the TWAIN interface, the EPSON TWAIN window 
doesn’t appear.)
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11 If you set up the Start button to load your scanned images into 
PageManager, click the Inbox  icon to view the images in 
PageManager. (See your PageManager documentation for 
instructions on processing images.)

If you set up the Start button to load the scanned images into your 
OCR application (or another application), PageManager processes the 
images and opens the application. After a moment, the scanned 
images appear in your selected application window.

12 Now you can follow the instructions in the documentation for your 
application or for PageManager to process your images as necessary. 
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Troubleshooting

If you encounter any problems using EPSON TWAIN, try the solutions in 
these sections: 

◗ Problems Using EPSON TWAIN

◗ Problems Using the Start Button

◗ Problems with Image Quality

If the information here doesn’t help you solve the problem, check with 
your dealer or contact EPSON. See Where To Get Help for contact 
information.

Problems Using EPSON TWAIN

The rows in the Screen Calibration dialog box never seem to match closely enough.

Problem Solution

You’re viewing the 
screen too closely.

View the screen from a short distance when you calibrate it. The gray 
stripes won’t blend perfectly together; however, try to make them match 
as closely as possible.

Your monitor 
adjustments may be 
off.

Try adjusting your monitor’s brightness and contrast settings.
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When you select a TWAIN source, EPSON TWAIN isn’t listed.

EPSON TWAIN doesn’t start.

Problem Solution

EPSON TWAIN wasn’t 
installed or it wasn’t 
installed correctly. 

Reinstall the software following the instructions in the Scanner Basics 
book.

Problem Solution

The scanner isn’t 
ready.

Make sure your scanner is turned on and the cables are connected 
properly. Also make sure you turned on your scanner before starting 
EPSON TWAIN. If you started EPSON TWAIN first, exit the program, 
turn off your scanner, turn it on again, and reboot your system.

Your system doesn’t 
meet the minimum 
requirements.

Make sure your computer, scanner, and software are compatible and 
meet the specifications under System Requirements. 

EPSON TWAIN needs 
more memory.

Make sure EPSON TWAIN can access enough system memory. See 
the section on memory allocation in your computer manual.

EPSON TWAIN is not 
selected as your 
TWAIN source.

EPSON TWAIN may not be selected as the TWAIN source in your 
application. See Starting EPSON TWAIN for instructions on selecting it.
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The scanner does not start scanning.

A system error has 
occurred.

An error condition may have caused your application or the TWAIN 
source to stop working correctly. Save any documents in process, close 
any open applications, and restart Windows: then start your application 
and try again.

Sometimes an error condition may cause the computer to display a 
message telling you that your scanner is not recognized. If this happens, 
turn the scanner off and then on again; then restart your computer and 
try again.

Problem Solution

The scanner isn’t 
ready.

Check if the scanner’s operate light is on. If not, press the 

 

Poperate 
button. Then restart your computer and try scanning again.

You’re scanning a large 
image and running out 
of system memory.

If the image you’re scanning is too large or if your system has a 
minimum amount of memory installed, you may run out of memory when 
you scan. You’ll usually get an error message or your system locks up 
when this happens. Reduce the image size or resolution and try 
scanning again. If you still can’t scan the image, add more system 
memory.

If you’ve just scanned a large image in your application and then 
immediately scanned another, the application may not have released 
the memory allocated for the first image. Close your application, restart 
it, and try scanning again. If restarting your application doesn’t solve the 
problem, you may need to reboot your computer.

Problem Solution
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You have trouble batch scanning.

You cannot scan images at all or only a few dots appear in the scanned image.

Problem Solution

Your application 
program doesn’t 
support batch scanning 
or you don’t have 
enough system 
memory.

Some applications don’t support batch scanning. When you try to batch 
scan or use the optional auto document feeder with this type of program, 
you get an error message or the system locks up. Check the program 
documentation and, if necessary, use another program for batch 
scanning.

You also may not have enough system memory for the batch scan. Try 
reducing the document size, scanning fewer pages at once, or adding 
more system memory.

Problem Solution

You may have selected 
incorrect scan settings.

Select different EPSON TWAIN settings. You may have selected an 
incorrect Image Type or Destination setting, or the Exposure, Highlight, 
and Tone Correction settings may be inappropriate for your image. See 
Advanced Scanning for details.
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Problems Using the Start Button

You see the message “No Push button scanner detected.”

When you press the Start button, nothing happens.

Problem Solution

Scanner monitoring 
doesn’t detect the 
scanner.

The EPSON Scanner Monitor periodically checks on the status of your 
scanner to make sure it’s ready. Sometimes the scanner check occurs 
when your system is processing other information and the scanner is not 
detected during that particular check. (You may see this message 
anytime, not just when you press the Start button.)

If you see this message, make sure your scanner cable is securely 
connected. Then open and close the scanner monitoring utility to 
manually check for the scanner. See Enabling Scanner Monitoring for 
instructions. If you still see the message, turn off your scanner, then turn 
it on again and restart your system.

Problem Solution

Scanner monitoring is 
not enabled.

Scanner monitoring must be enabled for the Start button to work. See 
Enabling Scanner Monitoring for instructions.
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When you press the Start button, your system opens programs and scans slowly.

PageManager is not 
installed or the scanner 
monitor isn’t pointing 
to it.

Make sure you installed PageManager correctly, as described in the 
Scanner Basics book. Also make sure the scanner monitoring utility still 
points to PageManager as the target application for Start button 
scanning. See Enabling Scanner Monitoring for instructions.

If PageManager starts, but you don’t see the EPSON TWAIN window, 
make sure the destination program or device you assigned to the Start 
button does not suppress the EPSON TWAIN interface. See Assigning a 
Destination to the Start Button for details.

Problem Solution

You assigned another 
destination program to 
the Start button in 
PageManager.

When you set up PageManager to automatically send files scanned with 
the Start button to another application, scanning may take longer. This is 
because your system must use extra resources to open PageManager 
and EPSON TWAIN, and then scan your image, process it, and send it 
to another application. 

Problem Solution
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Problems with Image Quality

Images are very dark and without details.

The image is distorted or blurred.

Problem Solution

Some EPSON TWAIN 
settings may be set 
incorrectly.

Make sure the Destination (output device) setting is set to Screen/Web. 
If you selected a printer as the Destination setting, the image may more 
closely match the original when printed, but not when displayed on the 
screen.

Change the Exposure, Tone Correction, and Shadow settings to lighter 
values and scan the image again. See Advanced Scanning for 
instructions on changing these settings.

Problem Solution

The document isn’t 
positioned correctly on 
the document table.

Make sure that the document is placed flat against the document table 
and that no part of the original is wrinkled or warped.

You may have moved the document during scanning. Check the position 
of the document.

Make sure the scanner isn’t tilted or placed on an unstable surface.
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Color is patchy or distorted at the edges of the document.

The image is faint or out of focus.

Problem Solution

The document isn’t 
placed correctly on the 
document table.

If the original is very thick or warped at the edges, the edges of the 
image may be discolored. Cover the edges of the original with opaque 
paper to avoid interference from outside light. 

If part of the original is outside the document table, the edge may be 
discolored. Change the position of the original.

Problem Solution

The document isn’t 
positioned correctly on 
the document table.

Make sure the document is placed flat on the document table.

Some EPSON TWAIN 
settings may be set 
incorrectly.

Check your Tone Correction setting and/or select a darker Exposure 
setting. See Advanced Scanning for instructions on changing these 
settings.

Your monitor isn’t 
calibrated or isn’t 
adjusted correctly.

Make sure you have calibrated your monitor to your scanner as 
described in Using the EPSON Screen Calibration Utility. Also check 
your monitor’s brightness and contrast settings. Make sure the 
Destination (output device) setting is set to Screen/Web  in EPSON 
TWAIN.
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The colors on the monitor seem different than the original image or printed image.

The printed image is larger or smaller than the size of the original.

Problem Solution

Your monitor may not 
be calibrated correctly.

Depending on your monitor, its resolution/color settings, and your 
EPSON TWAIN settings, the screen colors may be different from the 
original colors. This may be normal, especially if the colors in the printed 
image more closely match the original. Make sure you have correctly 
calibrated the screen as described in Using the EPSON Screen 
Calibration Utility.

Some EPSON TWAIN 
settings may be set 
incorrectly.

Check your Image Type and Destination settings to make sure they are 
correct for the type of image you’re scanning and for the output device 
you’re using. See Selecting Basic Settings for instructions on changing 
these settings.

You may need to use a 
color correction mode.

The colors in the printed image may not match the original image exactly 
because the scanning and printing processes use two different color 
interpreting technologies. Use the ICM/sRGB (Windows 98) or ColorSync 
(Macintosh) settings in EPSON TWAIN to more closely match the colors. 
See Configuring Preview and Color Options for instructions. 

Problem Solution

You may have changed 
the Target image size 
or used the Zoom 
Preview feature. 

Check the image size settings in your application and EPSON TWAIN; 
see Adjusting Source and Target Image Sizes for details. Don’t use the 
size of the image on your monitor to judge the printed size; you may 
have used the Zoom Preview feature, which only affects the preview 
image size. Also, some applications display high resolution images on 
lower resolution monitors so they appear larger than their original size. 
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The printer can’t print the image, or the printout is garbled or isn’t an image.

The quality of an enlarged image is worse than when it’s scanned at its original size.

Problem Solution

Your printer and 
computer may not be 
securely connected.

Check that the printer is properly connected to the computer and is 
correctly set up; see your printer manual.

Your software is not 
installed correctly for 
your printer.

Check that your application software is properly installed and set up for 
your printer; see your application software manual.

Problem Solution

You didn’t increase 
your Resolution setting 
to compensate for the 
image enlargement.

If you enlarge your target image size by scaling or by selecting a larger 
Target size, be sure to increase the Resolution setting by the same 
proportion to retain your image quality. For example, if you select 
300 dpi as the resolution setting for an image scanned at 100% of its 
original size and then scale the image 200%, you should increase (in 
this case, double) the resolution to 600 dpi to retain the same image 
quality. See Selecting Basic Settings for instructions on changing the 
Resolution setting.

For additional information on selecting scanning resolution, see your 
Scanner Basics book.
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Moiré (crosshatch) patterns appear in the scanned image.

Character recognition is inaccurate after OCR scanning.

Problem Solution

You have scanned a 
document with halftone 
patterns.

To minimize moiré patterns, try the following:

◗ Place a transparent sheet between the document and the document 
table to slightly unfocus the image.

◗ Move or angle the document slightly.

◗ Adjust the Sharpness setting to a lower value to unfocus the image. 
See Customizing Destination Settings for more information.

◗ Change the Target image size setting slightly.

◗ Make sure De-screening is turned on in the Image Type dialog box. 
See Customizing Image Types for details.

Problem Solution

You scanned the 
document using 
incorrect Image Type 
and Destination 
settings.

Scan the document again using OCR as the Image Type and 
Destination settings in EPSON TWAIN. This automatically turns on the 
Text Enhancement Technology setting that eliminates background 
document noise. See Selecting Basic Settings for details.

If character recognition is still too inaccurate, change the Image Type 
setting by selecting None  for the B/W (Black & White) option setting. 
Then adjust the Threshold setting in the Image Controls dialog box; see 
Adjusting Image Controls for details. Try scanning again.
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Where To Get Help
EPSON provides technical assistance through electronic support services 
and automated telephone services 24 hours a day. The following tables 
list the contact information:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com .

EPSON Internet FTP Site If you have Internet FTP capability, use your Web browser 
(or other software for FTP downloading) to log onto 
ftp.epson.com  with the user name anonymous  and your 
e-mail address as the password.

EPSON Forum on CompuServe® Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 
and ask for representative #529.
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To speak to a technical support representative, dial (310) 974-1970 (U.S.) 
or (905) 709-3839 (Canada), 6 AM to 8 PM, Pacific Time, Monday through 
Friday. Toll or long distance charges may apply.

Before you call, please have the following information ready:

◗ Product name (EPSON Perfection 1200)

◗ Product serial number (located on the back of the scanner)

◗ Computer configuration

◗ Description of the problem

You can purchase optional equipment, manuals, and accessories from 
EPSON Accessories at (800) 873-7766 or visit our web site at 
www.epsonsupplies.com (U.S. sales only). In Canada, please call 
(800) 873-7766 for dealer referral. 

Automated telephone services

Service Access

EPSON SoundAdvice For pre-recorded answers to commonly asked questions 
about EPSON products 24 hours a day, seven days a week, 
call (800) 922-8911.

EPSON FaxAdvice™ Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to 
use this service.

EPSON Referral Service For the location of your nearest Authorized EPSON Reseller 
or Customer Care Center, call (800) 922-8911.

SM

If you need help using 
another manufacturer’s 
software with an 
EPSON product, see 
the documentation for 
that software for 
technical support 
information.
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Glossary

bit Short for binary digit. The smallest unit of data in computer processing. A 
bit can represent two values, on and off, or 1 and 0.

bit/pixel The unit that indicates the number of bits allocated for a pixel. The larger 
the value, the more detail a pixel can represent.

color correction A method of adjusting the color image data for a particular type of device 
so that the reproduction results come close to the original colors.

default A set of values used when no other selections have been made.

dither A process in which software or an output device simulates continuous 
tones with groups of dots.

dpi Dots per inch. A unit of measurement for resolution. The higher the value, 
the higher the resolution.

Dropout An EPSON TWAIN option that lets you select a color for the scanner to 
ignore.

Halftone A method of using dot patterns to represent an image.

marquee A sizeable and moveable frame on a preview image that identifies the 
part of it selected for scanning.
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monochrome Black and white images, or images represented only by the intensity of 
luminosity.

pixel Short for picture element. Every image is composed of a number of 
pixels. Pixels are also counted in units of dots.

resolution Indication of how finely an image is resolved into pixels. Measured in dots 
per inch (dpi), pixels per inch (ppi), or samples per inch (spi).

scan An operation performed by the sensor and the carriage of a scanner. The 
sensor “reads” the colors in an image, and sends the color information to 
the computer as digital data.

Threshold An EPSON TWAIN option that sets the point at which gray values in an 
image are represented as either black or white.
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Index

A
Accessories, 96
Advanced scanning, 23 to 51
Advanced window, 15, 19, 27, 31, 58
Auto Area Segmentation, 8, 17, 25, 29, 35
Auto document feeder

Document Source setting, 16
scanning with, 28 to 32
scanning with Start button, 78 to 83

Auto Exposure, 39 to 42, 50 to 51
Auto Locate, 31, 39 to 41
Automatic adjustment features, 39 to 41

B
B/W (Black and White) options, 35, 94
Basic scanning, 9, 13 to 22
Batch scanning, 21, 48 to 49, 87

C
Calibration

problems, 84, 91 to 92
utility, 10, 53

Color Adjustment settings, 46 to 47
Color buttons, 42 to 44
Color correction options, 50 to 51, 92
ColorSync, 11, 27, 31, 50 to 51, 92
Configuration settings, 50 to 51
Copying images, EPSON Scan! II, 63
Custom settings

destinations, 36 to 37
image types, 33 to 35
saving, 48 to 49
tone correction, 45

D
De-screening setting, 35
Destination setting

ADF settings, 30 to 31
basic settings, 16, 18 to 19
problems, 87, 90
transparency settings, 24, 26 to 27

Destinations for Start button, 70 to 75
Destinations, customizing, 36 to 37, 94
Document position problems, 90 to 91
Document Source setting, 16, 24, 28 to 29
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Dropout setting, 35

E
Easy window, 15, 58
EPSON

Accessories, 96
help, 95 to 96

EPSON Scan! II
copy feature, 63
exporting images with, 59 to 61
scanning with, 56 to 58
using, 56 to 63
view features, 62

Exporting images, EPSON Scan! II, 
59 to 61

Exposure setting, 42 to 43, 87, 90

G
Gamma setting, 42 to 43
Gray Balance Intensity setting, 46 to 47

H
Halftone setting, 34 to 35, 43 to 44
Help, 95 to 96
Highlight setting, 42 to 43, 87

I
Image Color Matching (ICM), 19, 27, 31, 

50 to 51, 92
Image Controls settings, 42 to 44
Image quality problems, 90 to 94
Image size, adjusting, 38 to 39, 92
Image Type setting

ADF settings, 28 to 31
basic settings, 16 to 19
problems, 87
transparency settings, 24 to 27

Image types, customizing, 33 to 35
Introduction, 8 to 12

M
Manual, how to use, 11 to 12
Marquees, 21 to 22, 40 to 41
Memory problems, 85, 86 to 87
Moiré patterns, 94
Monitor

calibrating, 10, 53, 84, 91 to 92
Macintosh, 11
Windows, 10

Monitoring utilities, 10, 52, 65 to 67, 
88 to 89
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N
Negative images, see Transparencies

O
One-touch scanning, see Start button
Optical Character Recognition (OCR), 17, 

25, 29, 94
Output device

ADF settings, 30 to 31
basic settings, 16, 18 to 19
customizing, 36 to 37
problems, 87, 90
transparency settings, 24, 26 to 27

P
Pixel Depth setting, 34 to 35, 43 to 44, 46
Presto! PageManager

adding destinations, 72 to 74
assigning destinations, 71
problems using, 89
reassigning destinations, 74 to 75
scan button settings, 75 to 77
Start button scanning, 78 to 83
Start button setup, 70 to 77

Previewing
configuring options, 50 to 51
documents with ADF, 31 to 32
images, 20 to 22

Problems
image quality, 90 to 94
printing, 93
using Start button, 88 to 89
using TWAIN, 84 to 87

Q
QuickTime, 11

R
Resolution setting

ADF settings, 31
basic settings, 16, 18 to 19
Destination options, 37
problems, 93
transparency settings, 24, 26 to 27

S
Saturation setting, 46 to 47
Scale settings, 38 to 39
Scan button settings, PageManager, 

75 to 77
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Scan Events, 10, 52, 65, 67, 88
Scanner monitoring, 10, 52, 65 to 67, 

88 to 89
Scanning

advanced, 23 to 51
basic, 9, 13 to 22
batch, 21, 48 to 49, 87
transparencies, 24 to 27
with ADF, 28 to 32
with Start button, 78 to 83

Scanning mode setting, 35
Screen calibration

problems, 84, 91 to 92
utility, 10, 53

Service, 95 to 96
Settings

button, 48 to 49
problems with, 87, 90 to 94

Shadow setting, 42 to 43, 90
Sharpness setting, 18
Software installation problems, 85, 93
Source settings, 38 to 39, 92
sRGB, 19, 27, 31, 50 to 51, 92

Start button
enabling scanner monitoring, 65 to 67
preparing to use, 64 to 77
problems using, 88 to 89
scanning with, 78 to 83
setting up PageManager, 70 to 77

Support, 95 to 96
System requirements

Macintosh, 11
problems with, 85
Windows, 10

T
Target settings, 38 to 39, 92 to 94
Text Enhancement Technology, 8, 17, 25, 

29, 35, 94
Threshold setting, 42 to 43, 94
Tone Correction settings, 44 to 45, 87, 

90 to 91
Transparencies

Document Source settings, 16
scanning, 24 to 27

Troubleshooting, 84 to 96
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TWAIN
basic settings, 16 to 19
previewing, 20 to 22
problems using, 84 to 87
starting, 14 to 15, 56 to 58
suppressing interface with Start button, 

72 to 77, 80, 89

U
USB interface, 10 to 11
Utilities, 10, 52 to 55

V
View features, EPSON Scan! II, 62

Z
Zoom Preview, 20, 92
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